
About
Tells you which version of enotate you are using and how to contact Informal Software.



About the LDF file format
LDF is a communication protocol that is used by enotate to communicate with the enotate Palm 
application. It describes the drawing in a propriety format that enotate stores as a document.
When you draw on the enotate Palm application, data is sent to the enotate PC application which then 
draws the same drawing on the PC.
The communication works from the PC to the Palm as well, which allows the Palm to show the LDF 
drawing that is on the PC.
The LDF drawing is separate from any graphic that you paste into enotate, so any changes that you make
to the LDF do not affect the graphic.
When you send an enotate document as an email attachment, any graphic that is pasted in is sent as a 
LDF or JPG (see Preferences) embedded in the enotate document, along with the LDF.



Clear Screen
Clears the enotate document or the selected layer.



Communication Problems
If your enotate software tells you that there is an error connecting to the Palm, then check the following:

Is the Palm in the HotSync® Cradle?
Is the HotSync® cradle lead plugged into your PC?
Is the enotate.prc file installed on the Palm? If not, then refer to your Palm manual to install the 

enotate Palm application.
Is the communications port set correctly? Check the Communications Port setting.

You can confirm that your Palm is communicating with your PC by using the About menu item. It tells you 
if enotate is connected or not.

With enotate your PC and Palm only communicate when they need to pass data. This greatly reduces 
battery usage on your Palm.
Because of this we recommend that you always let the actions complete on both the PC and Palm before 
performing further actions. For example, exiting enotate on the Palm whilst enotate on the PC is 
performing an action may result in data loss.

If you are still having problems, then look at the enotate web site, http://www.informal.com for 
more information.



Communications
You can set enotate's com port to a different port than the one used for hotsyncing. Open Preferences 
from the Edit menu. Choose the port from the Communications port drop down menu. This setting is 
saved when you exit enotate.



Contents
Introduction
Using enotate
Menus
Toolbar
Using enotate on the Palm
Problems



Copy
Places a copy of the selected area on the Windows clipboard in bitmap format.
If you copy and then paste an LDF part of the document, it then becomes a bitmap.

You can also use the  icon on the Toolbar.



Copies the selected area of the document. For more information, see Copy.



Copying Graphics into enotate
You can copy graphics into enotate, and then draw over them using the Palm to annotate them. Uses for 
this include drawing a circle around someone in a picture, or adding arrows to a map for directions.

To paste a graphic into enotate, copy it from another application onto the clipboard, and then paste it into 
the enotate document. The graphic appears in a blue dashed box, that you can move anywhere around 
the document. Graphics are always pasted into the background layer.



Cut
Deletes the currently selected area and places a copy on the Windows clipboard in bitmap format.

You can also use the  icon on the Toolbar.



Cuts out the selected area of a document. For more information, see Cut.



Edit Menu
Clear Screen
Undo
Redo
Cut
Copy
Paste
Preferences



Exit
Quits enotate, and gives the option of saving changes if the current document has been modified since 
the last save.



File Menu
New
Open
Save
Save As
Send Email
Print
Print Preview
Print Setup
Recent Files
Exit



Help
Contents
About



This help file.
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Introduction

enotate makes your Palm into a real-time annotation and drawing tool. When you draw on your Palm, it 
also appears on your PC.
If you paste a picture, such as a map, into enotate, you can draw over it. This allows you to add arrows 
and lines to the map, for giving directions. enotate has many other uses, limited only by your imagination.
Where enotate really comes into its own is when you use it with your email software. You can create a 
drawing using enotate, and by using a menu item create a new email document with the drawing as an 
attachment. All you do is add the address and you can instantly send the drawing.



Menus
File Menu
Edit Menu
View Menu
Layers Menu
Help



New
Creates a new enotate document. You can only have one document open at a time. If you already have a 
document open when New was selected, then you are given the option to save it if any changes were 
made since the last save.

You can also use the  icon on the Toolbar.



Creates a new document. For more information see New.



Open
Opens an enotate document (.ldf) using the standard Open dialog box.

You can also use the  icon on the button bar.



Opens an enotate document. For more information, see Open.



Paste
Copies the contents of the Windows clipboard to the top left of the current viewable area in bitmap format.
It can then be moved to the required position by clicking and dragging using the left mouse button on the 
edge of the graphic when the cross arrows cursor appears. It retains its original file format such as DIB.

You can also use the  icon on the Toolbar.



Pastes the contents of the clipboard into the current document. For more information, see Paste.



Preferences
Allows you to set the file format used for images that have been pasted into enotate when using Save, 
Save As or sending an email attachment using Send Email, and for setting the com's port.

Save imported images as:
You have two options:

Windows DIB creates large file sizes but 
is a graphic is saved without any loss of detail.

JPEG creates small file sizes, but to 
make the file smaller some detail is lost. This is 
generally not noticeable.

If the recipient has enotate, then they will be able 
to view the JPEG or DIB file with the annotation 
overlaid.

File format for sending email:
Sets the file format that the enotate document is 
sent in when you use Send Email.
You have three choices:

Prompt Asks you when you select Send 
Email

JPEG The LDF part of the document is 
converted to a bitmap and embedded into the 
graphic

LDF The document is sent in LDF 
format, so it can be edited by anyone who has a 
copy of enotate.

Communication's port:
You can set enotate's com port to be the same as 
the port you use to HotSync® your Palm, or a 
different port from the drop down menu.

Print
Uses the standard Print dialog box for printing the current enotate document. You can also choose a 
different printer using this dialog.

You can also use the  icon on the Toolbar.



Prints the current document. For more information, see Print.



Print Preview
Shows how the current document will print.



Print Setup
Allows you to set the printer, paper size and orientation.



Save
Saves the enotate document, including any graphics that have been pasted into it, with the file name and 
in the location that you specify using the standard Save dialog box. If the current document has already 
been saved, then Save will replace the previous document with the current one.
You can save the file in different formats, which affects how it can be viewed, using the options in 
Preferences. If the file is saved in LDF format, it can be edited by enotate. If any other format is chosen, 
and LDF part of the document is converted to bitmap and embedded in the graphic.

You can also use the  icon on the Toolbar.



Save As
Saves the enotate document, including any graphics that have been pasted into it, with the file name and 
in the location that you specify using the standard Save As dialog box. This allows you to change the file 
name and save the document in a different location on the disk.
See Save for more information about file formats and saving documents.



Saves the current document. For more information, see Save.



Send Email
If you are using a MAPI compliant email program, then this command opens a new email document with 
the current enotate document set as an attachment, using the options set in Preferences.



Sending a document as an email attachment
You can send a document as an email attachment from enotate by using the Send Email menu 
command, or Send Email from the Options menu on your Palm.

This opens your email software with a new document with the current enotate document as an 
attachment, using the options set in Preferences. You then send your email as normal.
Your email software must be MAPI compliant, or your will not have this menu option.



Status Bar
Shows or hides the status bar.



The enotate Document
enotate creates a document that is 3200 wide by 2400 pixels high in standard view. You can zoom in and 
zoom out of the document to give you different views of the document. When you scroll around a 
document, the red dashed drawing box moves so that it is always visible on the screen. The drawing can 
be erased from either the PC or the Palm application
The document can be saved, and a new document can be created at any time. You can also open a 
previously saved document. 
The document has two layers, the background layer into which you can paste graphics, and the 
foreground layer where the drawing takes place. The layers can be edited separately.



Toolbar
Shows or hides the Toolbar. The Toolbar may also be moved by click and dragging on the Toolbar 
background. To put the Toolbar back to its docked position, drag it to the top of the screen.



Toolbar

The Toolbar provides a faster way of accessing some Menu items.
Click on a button to get a description of its function.

The Toolbar may also be moved by click and dragging on the Toolbar background. To put the Toolbar 
back to its docked position, drag it to the top of the screen.



Using enotate
When you first start enotate on your PC and then enotate on your Palm, you see a document window on 
the PC and a drawing window on the Palm. 
In the document window is a red dashed box. This is the drawing area. It is the same size as the Palm 
drawing area. Whatever you draw on the Palm in enotate appears here. It can be moved to a different 
position by clicking and dragging using the left mouse button on the edge of the box when the cross 
arrows cursor appears. It can also be moved by tapping the Draw button on the Palm and then dragging 
across the Palm screen.
When you move the box to a new location the Palm enotate drawing area shows any drawing and graphic
that is in the box. If you have drawn something, moved the box to a different location and then moved the 
box back over your drawing, it will appear on the Palm. 
You can use any of the enotate Palm application tools on your drawing, such as setting colors, erasing 
and different pen widths.

Copying Graphics into enotate
Sending a Document as an Email Attachment
The enotate Document
About the LDF File Format
Setting enotates com port



Using the Color Menu

The Color menu is accessed by using the Menu icon on your Palm. You can set the color that the lines 
drawn with your Palm appear on your PC. Each color also has a Palm command shortcut. The available 
colors with their shortcuts are shown below:

Color Shortcut
Black K
Red E
Green G
Blue B
Magenta M
Gray Y
White W



Using the Options Menu

The Options menu is accessible from the Menu icon on your Palm. Clear Screen (command shortcut C) 
clears the screen on both the Palm and the PC, or the selected layer.
Layers allows you to select which layer to work on.
Undo undoes the last action.
Redo redoes the last action.
Send Email starts your PC email application, attaching your enotate document to it. See Sending a 
document as an email attachment.
Preferences brings up a dialog box, allowing you to override the hardware buttons and set the smart 
acceleration mode. See Palm Preferences for more information.
Help brings up general help for the enotate on the Palm
About (command shortcut A) tells you the version of enotate you are using, and also if the Palm is 
communicating with the PC.



Using the Pen Menu

The Pen menu is always available. It gives you the choice of five pen sizes With these you can draw 
different size lines.



Using enotate on the Palm
You must have installed enotate.prc onto your Palm to use enotate. If you have not done so already, 
please refer to your Palm documentation on installing files.
Make sure that your enotate PC application is running, and that your Palm is in its HotSync® cradle or 
plugged into a HotSync® cable, and that it is plugged into your PC.
Start enotate as you would any Palm application. In the enotate application on your PC you will now see a
red dashed box. This is the same size as your Palm drawing area, and what you draw on your Palm 
appears there. If you do not see the red dashed box, or get a communication error message, then see 
Communication Error.

Using the Pen Menu
Using the Color Menu
Using the Navigate Menu
Using the Options Menu



View Menu
Toolbar
Status Bar



Zoom In
Shows more detail, but less of the document.



Zoom Out 
Shows more of the document, but with less detail.



Layers
enotate has two layers, the foreground layer and the background layer. All graphics are pasted into the 
background layer. All drawing takes place in the foreground layer. You can clear either layer by first 
selecting the layer using either the layers menu in the enotate application or layers in the option menu on 
the Palm. You can also clear both layers by selecting all layers.



Undo
Undoes the last action. enotate supports multiple undoes.



Redo
Redoes the last action after an Undo.



Layers Menu
The layers menu allows to select which layer you are editing. The background layer, the foreground layer, 
or all layers.



Undoes the last action. enotate supports multiple undoes.



Redoes the last action after an Undo.



Zoom Max
Gives you the maximum detail of the area your working on.



Zoom Min
Gives you a view of the document that shows the largest area on the Palm, but with the least detail.



Using the Navigate Menu

The Navigate menu gives you options to view more or less detail, using the zoom commands, Zoom In, 
Zoom Out, Zoom Max and Zoom Min. It also allows you to move your view of the drawing area that the 
Palm is showing. A faster way of moving the drawing area is to tap on the Draw button at the top of the 
Palm screen. See Moving the drawing area.



Moving the drawing area
You can move the drawing area by clicking on it with the mouse and then dragging it to a new location.
You can also move it using the move mode on the Palm. Tap on the Draw button at the top of the screen, 
and then drag across the Palm screen to move the drawing area box on the PC. Tap the Draw button to 
return to drawing mode. If set in the Palm Preferences, you can use the Palm buttons to zoom in and out, 
and move the document a page at a time.

Drawing mode Anything drawn on the Palm screen 
appears on the PC in the drawing area

Moving Mode Drag across the Palm screen to move 
the drawing area on the PC

Date Book 
Button

Page Left Pages the document and the drawing 
area to the left

Address Button Zoom In Provides a closer view of the document

Up and Down 
Buttons

Page Up and Page Down Pages the document and drawing area 
up or down

To Do
Button

Zoom out Provides a less detailed but wider view 
of the document

Memo Pad 
Button

Page Right Pages the document and the drawing 
area to the right.

Palm Preferences

Override hardware buttons if checked, then the Palm buttons can be used to zoom the drawing area 
and move the document. See Moving the drawing area for more information.
Smart acceleration, when checked, sets the Moving mode so that the further you drag across the palm 
screen, the faster the drawing area is moved on the PC.



Problems list
Communications
Palm buttons not working



Palm buttons not working
If the buttons on your Palm are not working as you expect, it is because enotate on the Palm uses them 
for zooming and scrolling. This feature can be turned off in the Preferences dialog.



Clear Button
Clears the enotate document or the selected layer.



No web browser found
A default web browser could not be found on your computer. Please open your browser and go to 
http://www.informal.com.



Recent Files
Lists the last four files opened in enotate. Selecting a file opens it.




